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Some Reviews of the DeskTop Set:

"Okna Corporation [DeskTop Set does]  for Microsoft's Windows what
Borland's SideKick does for OS/2 Presentation Manager".

Michael Hogan, PC World, September 1989

"[The  DeskTop  Set...]  admirably  replaces  Windows'  collection  of
desktop utilities."

"The Phone Book [...] is superb."
"The  Calendar  is  also  head  and  shoulders  above  Windows'
[Calendar]", 

"...if you're a Windows number cruncher, the on-screen tape may be
worth  the  price tag  --  especially  when a  tape can be  annotated,
globally edited, and saved for later reference. ...[It] even displays
the most recent session when you call up the Calculator."

Patrick Marshall, PC World, November 1989

"With a $149 list price, The DeskTop Set could be a bargain, even if
all you use is the Calendar and the Phone Book."

Michael J. Miller, InfoWorld, July 24, 1989

"[The DeskTop Set] is a very impressive piece of work."

Edward Mendelson, Contributing Editor, PC Magazine

New twists on Microsoft Windows are getting to be a dime a dozen
these days,  but  few are as  rich  in  features  as  The DeskTop Set.
Combinig  a  collection  of  powerful  desk  accessories  with  an
innovative  desktop  manager,  this  package  brings  real  flair  to
otherwise pedestrian Window [2.1] environment.

"[The  DeskTop  Set  is]  chock-full  of  rewarding  design  ideas  and
insights. If you are in the market for Windows desk accessories, it's
hard to do better than these."

Rock Miller, PC Magazine, January 30, 1990

"If you're going to work with Windows every day, The DeskTop Set is 
something you'll want to have and use."

"If you use Windows and you use the telephone, get yourself a copy of 
The DeskTop Set."

Martin Heller, Computer Shopper, July 1990



Product Synopsis and System Requirements
The DeskTop Set program for Microsoft Windows is intended for professional and 
personal use.  It consists of six integrated modules:  

o DeskTop Manager which features programs organizer, screen saver, system 
lock, file finder and system-wide access to every command.

o Phone Book which accepts unlimited number of records and features 
phonetic search, mail merge, data import/export, reminders, privacy 
features, Yellow pages, record links, printing and dialing.

o Memory Dialer, phone log, area-code directory, least-cost routing, calling 
cards dialing, custom dialing formats, modem customization.

o Accounting Calculator which allows you to print, save, recall, edit and copy 
and paste tapes.

o Calendar which accepts entries up to ten years ahead and features daily, 
monthly, annual and expense ledger modes.

o File Viewer which reads, formats and prints text documents of any size.

The DeskTop Set is the first Windows application to feature an Expert mode and 
Expert menus, proportionate fonts throughout, beautiful graphics, adaptive logic 
(programs always remember their last state; commands such as save  do not exist), 
advanced memory management, and many other innovative solutions.

In this demonstration package, you have the opportunity to use the Phone Book and 
Dialer programs.  These applications are intended to show you the minor subset of 
functionality that the retail versions provide.

System Requirements

To use the DeskTop Set programs, your system must meet or exceed the following:

o Microsoft Windows Version 3.0.
o IBM AT, PS/2, or compatible. The programs' design is optimized for speed. 

They will perform well even on 8 MHZ 640K PC AT models.
o The programs' memory architecture is highly optimized.  512K of memory is 

sufficient to run Windows in real mode with all DeskTop Set modules.
o A hard disk with at least 800K of available space after Windows has been 

installed.
o Hercules, EGA, VGA, Super VGA or 8514A video card. The program can't run 

in CGA mode because its graphical demands exceed the capabilities of  low 
resolution monitors.

o Mouse (optional).
o Hayes-compatible modem (optional).



The DeskTop Set Demo Installation
The installation of The DeskTop Set demonstration files are simple. Perform the 
following steps:

o Exit windows
o Create a directory that you wish to place the demo files.
o Unzip the file OKNA.ZIP.
o Enter back into  Windows
o Install BOOK.EXE and DIAL.EXE in one of the Program Manager's folder, or...
o In the MS-DOS Executive or the File Manager, go to the Drive / Directory that

you placed the demo files.
o Double-click the file BOOK.EXE and/or DIAL.EXE or their icons in the Program 

Manager folder.

The Phone Book will then open and automatically create two Phone Book files.  You're
now ready to go! The demo programs do not modify WIN.INI file.



The Basics
When you start Phone Book, it automatically opens to the page that you previously 
used.  If the book is initially closed, double click on the book cover or select 
File/Open Book command.
The Control bar across the top of the book contains four icons: left arrow, 
telephone, envelope, and right arrow.  The Alphabet controls along the sides of 
the page can be used to move quickly to the corresponding page in the Phone Book.  
The current letter is always displayed in the upper left corner of the page, and the 
page number is displayed in the upper right corner.  As you fill your Phone Book with 
entries, additional pages can be added.

What's the Expert mode?

You have an option in all DeskTop Set applications to operate them in either 
Windows or Expert mode.   Windows mode is the default choice; this allows the 
program to operate like other standard windows applications - pull down menu bar, 
caption bar, minimize & maximize buttons, etc .  The Expert mode has no menu and 
caption bars, but instead provides drop-down "floating" menus, which are 
accessible by clicking the right mouse button anywhere in a program window.  From 
Expert menus other menus appear as submenus.

You may find that the Expert mode and menus are easier and faster to use, it is less 
"cluttered" than the Windows mode, and the programs are much more attractive, 
but use whichever mode best suits your needs, or a combination of both.

The following is an example of the DeskTop Set Phone Book main menu; in Expert 
mode with a submenu selected:

The arrow on the menu indicates that a submenu is available.

To select a command from a submenu:

o Click the right-hand mouse button anywhere on the DeskTop Set program 
window and select the desired command (with arrow) from the menu that 
appears.

o Open the submenu by moving the mouse cursor slightly to the right until the
submenu appears, then select the desired command.

Unlike the standard windows method of accessing submenus, DeskTop Set 
applications in Expert mode employ an easier method.  As requested by DeskTop Set



users, you do not have to hold down any mouse button to access submenus.  After 
clicking the right-hand mouse button to bring up the main menu , you are free to 
release the mouse button and select any menu or submenu command.  This is a 
more natural way of accessing all menu options.  This attention to detail (and to user 
requests) pervades all DeskTop Set applications.

Remember that you can use the keyboard to select menu commands in the same 
way as with standard Windows menus. Use the left arrow key to open a submenu, 
and the Esc key to close.

Moving Through the Phone Book

To navigate around the book, use the following guide:

To Keyboard Mouse

Move to a  page: Ctrl + Letter Click desired letter
Move to the next page Page Down Click on right 
arrow
Move to the previous page Page Up Click on left arrow
Move to an entry Up & Down Click on entry
Move to an entries phone number Tabclick on phone

Adding Entries

Adding entries is easy; just remember the following rules:

o Enter the text, such as the persons name, nickname, business, etc in the left 
hand column.  Limit the entry text to one row; place any additional 
information in the notes area.

o Enter the phone number in the right column.
o Enter a area code for the phone number, even if it is a local call.  The 

DeskTop Dialer is smart enough not to dial the area code for local calls.

Entering Business Information

For any Phone Book entry, you can use the Business Information  dialog box to enter 
detailed information about a business contact.  In addition, you may add free form 
comments in the Notes area of the dialog box.  For those of you who deal with clients 
and accounts via the phone, you can give each entry an account number.  Whenever 
you dial your client, this account number then can be passed through to your phone 
system; simplifying your time / expense accounting .

To enter or edit business information:

o Select desired page entry;
o Select Edit/Business command in Windows mode, or...
o Select Business command from the Edit menu (click on envelope icon) in 

Expert mode.

To enter or edit residential information:

o Select desired page entry;
o Select Edit/Residence command in Windows mode, or...
o Select Residence command from the Edit menu (click on envelope icon) in 



Expert mode.

Viewing Entries

The View window shows at a glance all information about a selected Phone Book 
entry.  Business and personal information, phone numbers, reminders and notes are 
displayed simultaneously in a resizable, movable window.  Phone Book remembers 
the last size and position of the View window, and will display it there the next time 
it is opened.  Multiple View windows can be active at the same time, and they can be
arranged in a cascading fashion.  From a View window, you can dial any of the phone
numbers that are associated with this entry.
If you would like open View windows with a mouse double-click or press the Enter 
key, make sure that the View option in the Setup Book  dialog box is selected.

Additional View window functions:

o A mouse double click brings up a Dial menu.  There is no keyboard 
equivalent.

o The Page Down or Page Up keys toggle the enlarged and normal View 
display font.

o The System menu Close command closes the View window.
o Pressing Enter will also close an active View window. 
o A right mouse button click inside a View window opens the View menu.  There

is no keyboard equivalent.  The View menu allows you to do the following:
- Close will close the current window.
- Cascade will take all active view windows and cascade them from the center 

of the screen.  This option is greyed if only one view window is active.
- Records allows you to quickly move through multiple view windows.  By 

highlighting the name of the desired record you want to see, the selected 
record is then placed on top of all other View windows.  This option is greyed if
only one view window is active.

- Close All... closes all active View windows.  As above, this option is greyed if 
only one view window is active.

Dialing Entries

Phone numbers that you have entered into the Phone Book can be dialed 
automatically by using  Dialer.  Even if you do not have a modem or auto-dialer, you 
can use the Dial menu to quickly look up a number.  

To Dial a telephone number that appears in a Phone Book entry:

o Double-click a phone number that appears on the page, or... 
o Open Dial... on the menu bar or click the Telephone icon to dial another phone

number that may belong to this entry;
o Select desired command/number to place a call.

If the DeskTop Dialer was not previously open, it will automatically load and dial the 
requested number.  Be sure to review the DeskTop Dialer section to further customize
your dialing capabilities.

Phone Book Reference Information:



File Menu

Close book Closes (literally) Phone Book. Use the Open Book command to 
reopen;

Yellow Pages Opens Yellow Pages. What's the difference?... They are yellow. 
Yellow pages offer  a convenient way to view another Phone 
Book file without opening another Book (you can!). You may 
copy, cut and paste records between White Pages and Yellow 
Pages. (As well as with several open Phone Books).  When in 
Yellow Pages mode this command reads "White Pages".

List... Opens sorted (by page entry) list of all Phone Book records.
Double-click list's entry to open respective page. Check out an 
effect of typing someone's name while the list. windows is 
active.

Open... Opens "Open File" dialog box. Use is to select another file or 
create a new file.  Ignore the questions that come up when 
creating a new file; they are deactivated in the demo version.

Setup... Opens "Setup" dialog box. It displays some settings that are not 
applicable to demo version. If the rest are not self-explanatory, 
by all means, feel free to order a "real thing".

File Info... Opens a window that contain information about currently open 
file.

About... Opens a pretty window with version number, copyright, phone 
and address information. If this demo is old, the address and 
phone may be different. However, they are current as of this 
writing (June 20, 1990).

Quit... It does exactly that. I hope you will like the Phone Book so much,
that you never have to quit. Please keep in mind that Phone 
Book does not have Save command. It saves everything in real 
time. So, feel free to crash any time... - the Phone Book's data is 
save and saved.

Edit Menu

Business Opens dialog box to enter and edit Business information

Residence Opens dialog box to enter and edit Residential information

Copy The Copy command places a copy of the selected entry and
stores it in the internal clipboard so that it can be pasted 
elsewhere in the Phone Book.  It is not linked in any way to the 
source entry, and can be modified to suit the new entry after it is
pasted. You can also copy business or home (shift key down) 
address into any word processor by just drugging phone book 
entry into its window. Just click and hold the left mouse button 
down until it changes shape, and then drag into window or icon...
The copy formats are stored in firm.mov and home.mov files. 
These files can be modified using Windows' Notepad.

Paste The Paste command inserts the information that is in the 
internal clipboard from a previous Phone Book Cut or Copy 
command.  It will not paste information from other Windows 
applications; just from the Phone Book.  The reason for this is 
clear: when you copy information from another application, you 
know whether it's business or residential information, but the 



Phone Book (and any other application) can not distinguish the 
difference.   You need to enter the correct area, such as business
or residential information, and use the local Paste command 
button.  This makes sure that the information is placed in the 
appropriate area.

Cut The Cut command removes the currently selected entry 
and stores it in the internal clipboard so that it can be pasted 
elsewhere in the Phone Book. 

Clear The Clear command removes the currently selected entry 
without pasting it on the clipboard.  The information, therefore, 
cannot be pasted or copied.  Since the Clear command can not 
be reversed, make sure that you want to clear the entry before 
selecting this command! 

For those users with a mouse, two other functions are available: 

Move Move is not present on any menu, and does just as its 
name implies, moves entries to another place on a page, or 
another page entirely.  To move an entry to another location on 
the same page, simply click on the entry and hold it down until 
the mouse pointer changes. After the pointer changes, move to 
the desired location, and click again to place it there. 

Xfer  You can copy entries between Phone Books by opening two 
books, selecting the appropriate "to" and "from" pages, and 
dragging the entry you want copied to the target book and 
clicking on the desired page location. (See Copy command 
above. Also works with Dialer and Calendar)

Search Menu

Phonetic The Phonetic search is one of the most useful functions in the 
Phone Book.  The entire Phone Book can be searched in seconds 
for the "wordz zat sount alike".  What's more, the complete 
results are displayed in a list box, so that you may determine at 
a glance whether the item you're looking for has been found.  
Once you find the name you're looking for, a quick double click 
will position the Phone Book to the right page and highlight the 
entry for you.

Telephone The Telephone number searches allows you to search for what 
number you are looking for by entering the exact number or 
"wild card" numbers.  Once entered, the program goes page to 
page stopping on the entry that matches the search criteria.

Account Basically the same as telephone searches.  If any entries match 
your criteria, the Phone book will move to the appropriate page 
and highlight the entry that meets your criteria.

Dial & Numbers Menu

Entry numbers Each phone number slot -  Entry, Office, Home etc corresponds 
to the number entered into the currently selected Phone Book 



entry.  The first line indicates the entries name.

Paste Is an interpretation of a phone number from the data that 
exists in the clipboard.

Windows Menu Lists all applications currently running in windows.  Select one, 
and you will switch to the application you selected.



The DeskTop Set Dialer

...it offers an amazing array of fancy features, including least-
cost routing, support for calling-card accounts, and call 
logging. The dialer's setup options make it smart enough to 
handle international dialing codes and PBX prefixes of any 
complexity, and it can dial even after receiving phone has 
picked up, so you can use it to operate touch-tone systems."

Rock Hadson, PC Magazine, January 30, 1990

The DeskTop Set Dialer program, in both convenience and function, exceeds that of
the most sophisticated and expensive business telephones. It is integrated with the
Phone Book and Calendar and can get and dial  a phone number from any other
Windows program via Clipboard.

Fast, friendly, user configurable and "intelligent," the DeskTop Dialer, in combination
with the other  DeskTop Set  programs,  provides an automated phone directory  of
unlimited size and unmatched flexibility.

When  you  first  run  the  Dialer,  you  will  be  asked  to  provide  some  basic  setup
information.  To be able to dial out you must have a modem installed and connected
to a serial port.  Make sure you enter in your local area code so the system can strip
off  the  area  code  from  all  local  numbers  before  dialing.   If  your  phone  line  is
connected to a company PBX, make sure that you provide the correct prefix (i.e. 9 to
get an outside line) in the appropriate fields.

If Windows application (Cardfile, Terminal, CrossTalk, DynaComm, etc) can dial, than
the Dialer can. If they can't, than the Dialer can't nor can we help you in any way.
With some modems you may have a problem of hanging-up the modem. To remedy
the problem, check File/Modem... option  "Problem Modem - would not hang-
up".

The Dialer Controls

o Dial button (Enter  key) initiates a telephone call.
o Talk (Space  bar)  disconnects  your  modem  from  the  telephone  line  or

terminates the call in progress
o LND (Last Number Dialed) (F5  key) shows the last 10 numbers you dialed.
o Clear (Del key) clears the Dialer display area.
o The programmable Fire, Police and Ambulance (F1, F2, F3  keys) symbols

store and dial respective numbers.
o The  Telephone (F4   key)  symbol  dials  information  (411).   In  the  retail

version of Dialer, it opens a phone pad in which you can place 105 additional
names and phone numbers.

o The  Number Display may serve as a stopwatch timer. A left mouse click
starts and stops the clock.

Dialing a Number

Remember, you must have a modem installed and connected to a serial port to be



able to dial.  Use the Setup/Dialer menu to indicate a serial port number.

To dial a number:

o Select the number from the Numbers expert menu, or...
o Select the number from the Dial pull down menu, or...
o Enter the phone number from the keyboard, or...
o Type  the  letters  that  the  telephone  number  might  spell,  such  as  1-800-

FLOWERS
o Click Dial  button or Press Enter  key to dial the entered telephone number

and  the  the  Talk  button  orSpace  bar  to  begin  the  conversation  or  to
terminate the call. 

Dialer Reference Information:

File Menu

Setup... Opens "Setup" dialog box. this is where you define how your 
modem is connected, customize your dialing options, select the 
program mode, and define where you're located at the present 
time.  For all you portable users out there, make sure that you 
change the area codes when you travel so you can dial from 
anywhere.

Modem... This is the area that you techies can customize your modem 
settings from any modem you may possibly have.  The default 
settings works just fine for most Hayes compatible.  If you have 
an internal 1200 Hayes modem, click on the "problem modem" 
checkbox & Dialer will work just fine.

Copyright... Opens a pretty window with version number, copyright, phone 
and address information. If this demo is old, the address and 
phone may be different. However, they are current as of this 
writing (June 20, 1990).

Quit... It does exactly that. 

Dial & Numbers Menu

Entry numbers Each phone number slot -  Entry, Office, Home etc corresponds 
to the number entered into the currently selected Phone Book 
entry.  The first line indicates the entries name.  

Paste Is an interpretation of a phone number from the data that 
exists in the clipboard.

Windows Menu Lists all applications currently running in windows.  Select one, 
and you will switch to the application you selected.



Some Final Notes:

Okna Corporation is pleased that you have taken the time to review our 
demonstration programs.  Feel free to distribute these applications as you like.  We 
hope these applications give you a good indication of what the retail version of our 
package can deliver.  Bear in mind that these demonstration applications provide a 
minor subset of what functionality the retail versions' perform.  Below is a list of the 
functions that the retail versions of Phone Book and Dialer provide:

Phone Book
Print Facility  Your entries can be printed in any format you wish via the 

customized print format facility.  Prepackaged in each Phone 
Book is a format file that can print Mailing Labels, Day Timer 
forms, and even a pocket phone number directory!  The 
following picture is captured from the actual design formats 
facility:

Letters Letters can be composed and printed for both individual and 
category members.  One command prints out personalized 
letters for any entry(s) you desire.  You can also create merge 
files that can work in conjunction with your word processing 
application.

Entry Management As your Phone Book grows, its nice to know that you can 
still get to the desired entries by using several management 
tools, Categories, Topics, and Clones. 

The Categories function are among those nifty features that 



justify using $2,000+ PC as a Phone Book.  Certain classes of 
entries are associated with each other, but don't  necessarily 
belong together.  Examples of this could be vendors, clients, 
friends, ... each entry stands on its own, but can be related by a 
single distinguishable trait.  This "common trait" is best 
described as a category.  Entries can belong to several 
categories, i.e. a "friend and a client". 

Topics can be best described as a class of entries that are best 
managed by grouping them together.An example of this could be
members of the same company:  if you have 14 people you 
normally deal with at XYZ corporation, it may be easier to create 
a Topic called XYZ corporation and place all XYZ employees on 
this topic page.

Clones are what you would expect: an exact copy of another 
entry.  In certain situations, you may want an entry to belong to 
a certain Topic page and reside in a normal alphabet page.  With 
a cloned entry, any change in the master or clones' information 
is reflected in all associated entries.

Finally, to aid you in your Topic creation, You can also gather and 
move entries with ease with the Gather facility.  This function 
will gather and copy, move, or clone entries into another 
location, including Topic pages!

Alarms You can set alarms for entries to notify you of an upcoming event
at a certain time, and have the Phone Book move front and 
center over any application active at that time to notify you.  The
following dialog box highlights what all DeskTop Set applications 
strive for: ease of use.  To enter in an alarm, one simply clicks on
the appropriate date and time: the only keyboard interaction 
required is for the actual event note. 

Reminders You can enter in reminders for entries to make sure your don't 
forget that important event (like a birthday, or an anniversary!)

Adaptive Dialer The Phone Book will automatically dial any number in your 



Phone Book.  You also have the ability to individually set any 
phone number to dial in several different formats.  You can 
define a number as a a local, local +1, long distance, or 
international.  You can also define a number as an internal or 
external number, or choose to use a long distance carrier service
such as MCI, Sprint, or AT&T.  As with other DeskTop Set 
programs, the Phone Book remembers your settings and will use 
the format you selected the next time you dial.  Each dialer 
format can be custom tailored to your needs in the Dialer 
program.

NotePad You can attach a notepad document containing any information 
that you want to record for an entry.  The DeskTop Phone Book 
assigns a unique name to the text file the first time you use this 
command. 

Import / Export You Phone Book can selectively import and export entry 
information to industry standard file exchange formats.  Phone 
Book also has an intelligent Cardfile import facility to allow
you to migrate from the CRD format directly into the Phone 
Book!

LAN Support Phone Book Files can be shared by other Phone Book users 
across any local area network.

Dialer
Dialing Formats The DeskTop Set Dialer can accommodate a variety of PBX 

(Private Branch Exchange) systems and the specific needs of 
every user.  It is important to mention, however, that none of the
Dialer's simplicity has been sacrificed in the process.  The Dialer 
program has formats that can be customized for your particular 
needs.  If, for example, you consider an attorney with a large law
firm who, for billing purposes, must dial the client number in the 
following format: PBX - CASE CODE - PHONE NUMBER - 
ATTORNEY CODE every time he /she makes a call.  The DeskTop 
Dialer can simplify this 25 button operation into one single 
process: dial.  Your needs might not be as complex, but it is 
refreshing to note that all of your needs can be met with one 
program!  Since a picture tells a thousand words, below is the 
actual dial formats dialog box:



Memory Pad The DeskTop Dialer can locally store up to 105 of your most 
frequently dialed telephone phone numbers and names for easy 
access.  A 5-page (21 per page) memory pad; is provided on 
which you can store and dial the numbers. These numbers can 
be dialed "mnemonically". For example, typing "Mom" end 
pressingEnter  key will dial your mother phone number (if  it had 
been programmed, of course.)

Call Logging You can keep a record of the current call, its duration, and its 
purpose.  If the call has been initiated by the DeskTop Dialer or 
other DeskTop programs, then the name, phone number and any
other information that has been entered about the recipient of 
the call is automatically entered into the dialog box fields  You 
can review the information concerning all telephone calls that 
have been logged. 

Area Codes The Area Codes dialog box is a convenient tool to allow you to 
find out the area codes and local time for states and major cities.
You can also update and modify the information listed.

Least Cost Routing If you can use several long-distance services for your 
telephone calls, such as MCI or SPRINT, you may have noticed 
that calls to certain area codes are cheaper using one long-
distance service than another, while for another area code the 
reverse is true.  Of course, when you make a long-distance 
telephone call, you shouldn't have to worry about which service 
to use for the area code you are calling.  For this reason, the 
DeskTop Dialer allows you to set up a different long-distance 
service to use for each area code you dial. 

Services You may use the Dialer to send log-in codes, passwords and 
commands when using touch-tone services, such as bank-by-



phone, voice mail, digital pagers, etc. with the Touch Tone 
services function.

Also, four other programs are shipped with the DeskTop Set:  Calendar, Manager, 
Calculator, and File Viewer.

Calendar

The DeskTop Calendar; program is designed to provide you with a annual and 
monthly calendars, appointment book, "to do" list, and string-around-your-finger, all 
in one program.  All your important events can be monitored by five integrated 
views: To Do, Daily, Weekly, Monthly and Yearly.  The DeskTop Calendar includes the 
following key features:

o Displays the calendar for any year, in any century. 
o Shows national and major religious holidays for any year. 
o Keeps all of your appointment and date information within instant reach. 
o Never requires you to delete any past event to free up memory, since none of 

the information is kept in memory. 
o Allows the entry of appointment time in the 12- or 24-hour clock format. 
o Shows a full year calendar, from which you can select any day just by clicking 

the mouse. 
o Has an intuitive keyboard interface to speed up user interaction. 
o Allows the designation of calendar entries as urgent, pending or completed. 
o Allows you to set alarms as reminders to make calls or keep appointments. 
o Remembers and notifies you of alarms that have occurred while the Calendar 

and PC were shut down. 
o Integrates tightly with the DeskTop Phone Book and the DeskTop Dialer. 
o Offers both a Windows mode and an Expert mode.
o Provides comprehensive printer controls and formatting options.

Manager

The DeskTop Set Manager is a complex piece of software engineering that has been 
designed using exclusively the functions from the Microsoft Windows Software 
Development Kit - no undocumented functions, assembler subroutines or tricks of 
any kind have been employed. The DeskTop Manager gives you essential but 
forgotten functions, such as screen saver, windows lock, auto-save, program 
management utility, file finder and many others.   This program sits by, 
unobtrusively, until its needed.  The key features of the DeskTop Set Manager include
the following:

o "Hot Corners" function.  Each corner of the screen can be defined to perform a 
certain task: lock screen, blank screen, iconize active program, bring the 
Program Manager "up front and center", or bring up a customizable program 
launch menu.

o Program Launch menu.  You can create a menu that can run any windows 
application that you have installed from a click of the mouse.  You can define 
what directory your datafiles exist and have the menu provide you a list of all 
available datafiles to select whenever you load a certain application.  This menu
system works in concert with the Program Manager: it does not replace it.  

o You can manage all active programs by minimizing, maximizing, or cascading 
them by one click.

o If you ever wondered where that X@#$% file went to, the find file will help you 
locate it.  It can search network drives, and once you find it, you can even 



double click on it and load the appropriate application.

Tape Calculator

The Calculator; is designed to emulate and in many ways exceed the functionality of 
the various desktop calculators that are still in use next to PCs.  The key features of 
the DeskTop Set Tape Calculator include the following:

o Has the look and feel of a standard financial calculator. 
o Can remember and print tapes from previous sessions. 
o Entries and transactions that can be revised, copied, deleted, or inserted. 
o Can be controlled with the keyboard, mouse, light pen or touch screen. 
o Allows entries on tape to be annotated for easy reference. 
o Labels transactions with the time and date of entry. 
o Remembers a user-defined number of entries that are available the next time 

you use the calculator. 
o Allows you to customize the location of the tape window to be on the top or side

and to accommodate most types of monitor.

File Viewer

The DeskTop Viewer program is designed as a tool to read and print text files in the 
Microsoft Windows environment.  None of the commercially available Windows 
programs can read text documents without loading them completely into the 
computer's memory.  In addition, Notepad cannot read documents over 32K in size.  
These restrictions adversely affect Windows' usefulness to those who need to work 
with long text documents, such as reports, source code files, records of on-line 
sessions, etc.  The DeskTop Viewer does not have difficulties with any of these 
documents, regardless of length. 

The Viewer functionality is enhanced by the availability of flexible searching and 
bookmarking 
functions, an ability to copy and paste blocks of text into other applications, and 
printing support that allows page formatting and the use of all available fonts.  
Viewers' Key features include:

o Shows files of greater than 32K in size. 
o Allows short or long menus, for simple or full-featured operation. 
o Complete printing options, including headers and footers that can show the 

date, time, page, and file information. 
o Allows you to place a "bookmark" on any line of the file for easy return to the 

location at any time, even after shutting down your PC. 
o Ability to select different fonts for screen and printer. 
o Sets printer options without using the Control Panel program. 
o User-editable display colors. 
o Full access to other open applications. 
o Allows you to open multiple documents. 
o Allows you to split the screen to permit looking at different sections of the file at

the same time. 
o Provide advanced searching capabilities.

How to Buy...

For a limited time, Okna Corporation is offering a special for demo users.  Just tell us 



where (or how) you acquired the demo version, and for $89.00, we will send you a 
complete version of the DeskTop Set!  That's a $60.00 savings over the suggested 
retail price of $149.00.  This is our way of thanking you for taking time to review The 
DeskTop Set.

No other windows application provides so much functionality for the business user for
so little cost! 

Please send a check or money order for $89.00 to:

Okna Corporation
P.O. Box 522
Lyndhurst, N.J. 07071
Tel. 201-460-0677

Purchase Orders and C.O.D. orders are also welcome.

We'll send you a copy of the DeskTop Set right away.  With the purchase of the retail 
version, you get unlimited support for questions / problems / concerns you have with 
any DeskTop Set application.  Sorry, we can not provide technical support for any of 
the Demonstration applications, but will answer questions about the retail versions 
functionality so you can make an educated purchase.  Remember, all the files you 
created are compatible with the retail version - no conversion needed.

Thanks again for reviewing our products - we look forward to hearing from you!

June 20, 1990

P.S. If you are very good Windows-OS/2-Presentation Manager programmer and wish
one day to join our creative team, please drop us a line.


